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ASSAM HIGHER SECONDARY EDUCATION COUNCIL, GUWAHATI - 21 

HIGHER SECONDARY FINAL EXAMINATION, 2021 
Guideline for Online Form Fill-up 

 
This document will guide you through the operational aspects of Online Form Fill-up for Higher Secondary Final 
Examination of AHSEC.   

REQUISITE SOFTWARE / HARDWARE: 
1. Hardware: a) A Computer with a good internet connection. 

 b) A Scanner. 
 c) A LaserJet / Inkjet Printer. 

 
2. Software: a) Web Browser [Google Chrome (Version 50 and above) or Mozilla Firefox (Version 50  

  and above)]. 
     b) Adobe Acrobat Reader (Version 9 or above).  

 

Note : Before filling up the online application forms institutions are requested to keep ready all the details 
of candidates including photo (Maximum file size: 50 KB in JPG/JPEG format) and signature (Maximum 
file size: 20 KB in JPG/JPEG format).  

 
 

A STEP BY STEP GUIDE: 
1. Visit the Official Website of AHSEC (www.ahsec.nic.in) and click the link provided for Online Form Fill up Portal 

for H.S. Final Examination 2021. 
 

2. A new website as shown below opens up. 

 

i) In order to login into the portal, click on the button “Click Here” provided beside “Sign In” in this page. 
 

Note : 

a. Important information’s pertaining to HS Final Examination will be made available in the Notice 

Board section, kindly appraise yourself of the same before proceeding further. 
 

b. For additional queries (if any) you can call us or write to us at our details mentioned in “Contact us 

at” section. 
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3. FIRST TIME LOGIN: Clicking on the button “Click Here” provided beside “Sign In” in this page will open 

up a page as shown below. 
 

 

i) Enter your Login ID & Password. Please note the following: 

a. Passwords are case sensitive i.e. the system differentiates between “a” and “A” so please be 

careful while entering them. 

b. Change of Login ID is not allowed, hence do not disclose the same to unauthorized people and 

keep it confidential. 
  

Note: Upon entering a valid login ID, the system will do an internal check and the name of the 

institution who has been allotted the same will get displayed within a green bar atop the Login ID 

textbox. (This will serve as a check to verify the Institution name before you proceed further.)   
 

ii) Enter password in the textbox corresponding to the same. 
 

iii) Thereafter click on the “VALDATE” tab to proceed to the next page. 
 

 
 

In the page the system will display the logged into institution’s name in the upper part of the display. (This 

will serve as a check to verify the Institution name before you proceed further.) 
 

i) Enter Principal’s Mobile Number in the textbox and click on the “SEND OTP” tab. An OTP will be sent 

to the mobile number entered and a new textbox will appear for entering of OTP. 
 

Note: “SEND OTP” tab will remain inactive till no mobile number is entered in the column meant 

for the same. 
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i) Enter the OTP and click on “VERIFY” button. In case of OTP time out or not receiving of OTP, check the 
phone number and click on “RESEND OTP” button. Once the Phone Number is verified a new window 
will open for providing the school details. 

 

 
 

i) Fill up all the details as required and click on “SUBMIT” button. On successful submission, the system 
will direct to the institution’s home page for form fill up of the candidates. 
 

Note: Verification of Mobile Number through OTP is required only for first time login. 
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4. SUBSEQUENT LOGIN: Clicking on the button “Click Here” provided beside “Sign In” in this page will open 

up a page as shown below. 
 

 
 

i) Enter your Login ID & Password. Please note the following: 

a. Passwords are case sensitive i.e. the system differentiates between “a” and “A” so please be 

careful while entering them. 

b. Change of Login ID is not allowed, hence do not disclose the same to unauthorized people and 

keep it confidential. 
  

Note: Upon entering a valid login ID, the system will do an internal check and the name of the 

institution who has been allotted the same will get displayed within a green bar atop the Login ID 

textbox. (This will serve as a check to verify the Institution name before you proceed further.)   
 

ii) Enter password in the textbox corresponding to the same. 
 

iii) Thereafter click on the “VALDATE” tab to proceed to the next page. 
 

 
 

i) Enter OTP as received in the mobile number and click on the “SUBMIT” tab. Upon non receiving of 

OTP, click on “RESEND OTP” button. 
 

ii) On successful submission, the system will direct to the institution’s home page for form fill up of the 

candidates. 
 

Note: OTP will get delivered into the mobile number submitted in column Principal’s Mobile 

Number and the email address submitted at the time of initial login.  
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5. HOME: The home page serves as the dash board of the logged into institution. This page also provides 

certain vital information in a tabular format. 
 

 

 

i) The different pages where the user can move to from this page are:  

a. Change of Password. 

b. View the list of Tagged Non-Permitted Institutions (if any). 

c. Add New Candidate. 

d. Print Checklist (available only for added candidate’s) 

e. View & Print Duplicate Candidate List. 

f. Generate Bank Challan. 

g. Download of Unpaid Bank Challan and Challan Annexure. 

h. Download Final Statement & Question Paper Demand Summary. 
 

ii) In “Registration Summary” section user can view on real time basis; stream wise number of candidate 

added / modified in the portal, number of candidates submitted for challan generation, No. of Payment 

Advise Generated, and No. of Payment Advise remaining Unpaid 

 

iii) In “List of Candidate’s Enrolled by the Institution” section, a user will be able to view summarised 

details of Candidates whose details are present /added in the portal. 

Note:  

a) Data of all current year’s Regular / IP candidates (including candidates of tagged non-permitted 

institution submitted at the time of registration through the permitted institution) will be listed in 

this page. User is not required to add the same in the portal. In order to make the same eligible for 

challan generation, user is required to update the same.  
 

b) For preceding year’s Regular / IP / NIP candidate’s user is required to add the same into the portal 

using the option of “Add New Candidate”. 
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6. ADD NEW CANDIDATE: Using this page user will be able to add new candidates into the portal.   
 

 

Click on the appropriate tab to open up the applicable page for addition of candidate data.  
 

A. If selected option is one amongst the below mentioned; a page as depicted below / one with near similar 
resemblance opens up. 

 Regular / IP candidates (Registration between sessions 2010-11 to 2013-14 and has never 
applied for any HS Final Examination) 
OR 

 NIP Candidates willing to appear in all subjects (Unsuccessful candidates of HS Final Year 
Examination 2012 to 2015) 
OR 

 NIP Candidates willing to appear as certain subject candidates (Passed HS Final Year 
Examination 2012 to 2015 but unsuccessful in the Subject for which he/she is willing to apply), 
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i) In columns having drop down selection, select the appropriate option from amongst the list 

appearing in drop down. 
 

ii) In columns having radio button, select the appropriate option from amongst the available options. 
 

iii) In fields like Candidate Name, Aadhar Number, Father Name, Mother Name, Roll & Number of First 

Year Passing details enter correct details. 
 

iv) In order to move to the next page, click on the “Next” tab appearing in the lower part of the page.  
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NOTE:  
a. All fields marked with “*” are mandatory. 

 

b. Subject list will populate based on the stream chosen.  
 

c. A subject selected as an Elective cannot be reselected again as another Elective; in order to 
choose the same a user is required to de-select the first selection.  

 

d. Changing of selected Stream post selection of subject will result in remove the already selected 
subjects, a user is required to re-select all of them. 

 

 

v) Click on “Choose File” to browse through the computer and select the photograph of candidate to 
upload. 
 

vi) Click on “Upload Photo” to upload photograph of candidate. The uploaded photograph will be 
displayed in the screen. 

 

vii) Click on “Choose File” to browse through the computer and select the signature of candidate to 
upload. 

 

viii) Click on “Upload Signature” to upload signature of candidate. The uploaded signature will be 
displayed in the screen. 

 

ix) To submit the information of the candidate into the system click on “SUBMIT” tab. The system will 
accept the data and display a “thank you” screen in the form of an overlay. 
 

B. If selected option is one amongst the below mentioned; a page as depicted below / one with near similar 
resemblance opens up. 

 Regular / IP candidates (Registration between sessions 2014-15 to 2018-19 and have never 
applied for any HS Final Year Examination). 
OR 
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 NIP Candidates willing to appear in all subjects (Unsuccessful/Compartmental candidates of HS 
Final Year Examinations 2016 to 2020) OR Betterment/Re-appearance candidates (Passed HS 
Final Year Examination 2020). 
OR 

 NIP Candidates willing to appear as compartmental (Appeared and got Compartmental in HS 
Final Year Examination 2020) OR certain subject candidates (Passed HS Final Year Examination 
2016 to 2020) but unsuccessful in the Subject for which he/she is willing to apply) OR Backlog 
Candidates of Vocational Stream for HS Final Year Examination 2016 to 2020. 
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i) Enter requisite details in all column appearing before the “Prefill Tab” i.e select from the dropdown 

list / enter data in all columns appearing in para “Last HS Final Exam Appeared Details / Registration 

Details” and click on the “Prefill Tab”.  
 

ii) The system will validate entered details with its database and if found correct will display data in 

column Candidate Name & Stream and will also populate drop down list in column Appearance Type 

& Subject. (It is to be noted that the data displayed / list populated cannot be altered under any 

circumstances. Also the data entered in point no (i) mentioned above will become non-editable )   
  

iii) In case of others 
 

a. In columns having radio button, select the appropriate option from amongst the available 

options. 
 

b. In fields like Aadhar Number, Father Name, Mother Name, enter correct details. 
 

iv) In order to move to the next page, click on the “Next” tab appearing in the lower part of the page.  
 

NOTE:  
a. All fields marked with “*” are mandatory. 

 

b. Subject list will populate only after successful performing of point no (i) mentioned above.  
 

c. If multiple subjects are appearing under Elective, it is to be noted that a subject selected as an 
Elective cannot be reselected again as another Elective.  

 

d. If displayed details are incorrect / no details are displayed even after entering of correct 
information in para “Last HS Final Exam Appeared Details / Registration Details”, contact us 
at the earliest.     

 

 

 

v) Click on “Choose File” to browse through the computer and select the photograph of candidate to 
upload. 
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vi) Click on “Upload Photo” to upload photograph of candidate. The uploaded photograph will be 
displayed in the screen. 

 

vii) Click on “Choose File” to browse through the computer and select the signature of candidate to 
upload. 

 

viii) Click on “Upload Signature” to upload signature of candidate. The uploaded signature will be 
displayed in the screen. 

 

ix) To submit the information of the candidate into the system click on “SUBMIT” tab. The system will 
accept the data and display a “thank you” screen in the form of an overlay. 

 
NOTE:  

a. Data, photograph or signature of a candidate will only be uploaded into the system only after 
clicking on the “SUBMIT” tab. 

 

b. Candidate’s uploaded data, photograph and signature will be used for printing of the Academic 
Testimonials like Admit Card, Mark Sheet & Certificate hence please take proper care in making the 
same error free while entering / uploading of candidate’s data. 

 

c. Uploaded photograph should be of passport type, wherein the face of the candidate should be 
clearly visible. 
For uniformity purpose candidates should be advised to submit photograph of size 35 mm x 45 mm. 
The same should be scanned in quality ranging between 200 to 300 DPI.  

 

CORRECT PHOTOGRAPH 

   

INCORRECT PHOTOGRAPH 
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d. Uploaded signature should be clean and clear. 
For uniformity purpose candidates should be advised to put their signature in a white paper using 
black ball point pen only, in an area not bigger that 15 mm x 45 mm. The same should be scanned 
in black & white mode in quality ranging between 200 to 300 DPI.  

 

CORRECT SIGNATURE 

   

INCORRECT SIGNATURE 

 
 

 

   

 
  

 

  

 

7. PRINT CHECKLIST: Printing of Checklist is available for checking of candidate data entered into the 

online system. 
 

In order to print checklist of candidate data added into the online system, click on the “Print Checklist” tab.  

A new page as depicted below opens us.  
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i) If no selection is made checklist will be generated for all system selected candidates. In order to select 

candidate click in the checkbox (appearing before column serial number) corresponding to each 

record and click on the “PRINT” tab. (To select all records you can click on the checkbox placed in the 

table header.)  
 

ii) An alert box opens up asking for confirmation before proceeding to generate the file, click on “OK” 

tab in the alert box to generate the checklist. A new page opens up and thereafter the same will 

automatically close down and the checklist gets downloaded into your browser’s default location in 

PDF file format.  
 

iii) Double click on the file to open the same for printing. 
 

NOTE:  
a. Candidate’s data (including photograph & signature) once finally submitted into the system i.e. 

candidate record for which challan has been generated cannot be modified. Hence please take 
special care in checking the candidate data. 

 

8. MODIFY / EDIT / DELETE DATA: For Modification / Editing / Deleting of Candidate Data a user is 

required to perform the steps as mentioned below.  
 

In the user’s “HOME” page, list of all candidates added into the system by the user and the one’s made 
available to the user by the Council are displayed in a table under the banner “List of candidates enrolled 
by the institution”. 
 
 

 
 

Edit tab will be will be available corresponding to candidate data has been added into the system by the 
user and Modify tab will be available corresponding to candidate’s data has been made available to the 
user from council’s end.   
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NOTE:  
a. Candidate data which has not been finally submitted (i.e. challan not generated) till that time can 

only be edited. For them column “Submitted” will contain a “No” tag and in column “Action” both 

“Edit” & “Delete” tab / “Modify” tab (as the case may be) will be present corresponding to each 

record. 

 

A. Data containing “Edit” & “Delete” tab 
 

i) A data bearing “Edit” & “Delete” tab can be edited, editing of data, photograph or signature can be 

done till the same has not been submitted into the system for generation of challan. 
 

ii) Clicking on the “Edit” tab will open the candidate’s information sheet in edit mode enabling the user 

to edit all/requisite columns.  
 

iii) After editing page-1 of the data, click “Next” to photograph and signature upload page 
 

iv) For updating of photograph and/or signature please follow steps mentioned in para add new 
candidate. 

 

v) Thereafter to complete the process click in the “Submit” tab. The system will dsiplay a layover screen 
similar to the one displayed at the time of addition of the candidate’s data as confirmation of the 
data  being updated in the system.    

 

vi) In order to delete a candidate record click on the “Delete” tab located beside the “Edit” tab. Clicking 
on the same will open up an alert box. 

 

vii) In the alert click on “Ok” to confirm the deletion alternatively click on “Cancel” to cancel the process.  
 

NOTE:  
a. Data, photograph or signature of a candidate will only be updated after display of the thank you 

screen mentioned above. 
 

b. candidate record may not get updated if the steps mentioned above is not properly followed or the 
user moves into a new page after partially competing the above steps. 

 

c. After editing of candidate data, take printout of the same in the form of checklist to verify all 
required corrections have been made correctly.  

 

d. Data which have been finally submitted into the system i.e. for which challan has been generated 
will have “View” tab in column “Action” corresponding to them and the same can never be 
modified. Clicking on the “View” tab will open the candidate’s information sheet in view only mode. 

 

B. Data containing “Modify” tab 
 

i) A data bearing “Modify” tab has to be modified else the same will not be visible in challan generation 

page.  
 

ii) Modification is allowed in certain columns only. Columns like institution code, candidate name, 

father name, mother name, registration details & educational details cannot be modified the same 

will be visible in non-editable mode. 
 

iii) Clicking on the “Modify” tab will open the candidate’s information sheet in edit mode enabling the 

user to edit only requisite columns.  
 

iv) After editing of the data, click “Next” tab to submit the same.    
 

v) Clicking on the same will open up an alert window. In the alert click on “Ok” to confirm the deletion 

alternatively click on “Cancel” to cancel the process.  
 

NOTE:  
a. Data bearing “Modify” tab cannot be deleted under any circumstances. 
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b. Candidate record may not get updated if the steps mentioned above is not properly followed or the 
user moves into a new page after partially competing the above steps. 

 

c. Data which have been finally submitted into the system i.e. for which challan has been generated 
will have “View” tab in column “Action” corresponding to them and the same can never be 
modified. Clicking on the “View” tab will open the candidate’s information sheet in view only mode. 

 

9. VIEW DUPLICATES: Viewing, Editing and Deleting of duplicate records. 

 

 

i) This page lists all duplicate entries (if any) prevailing in the user’s entered database as on that time. To 
obtain a printout select the record(s) and click on the “Print” tab. 
 

ii) Please note candidate data pending final submission (i.e. those that have not been submitted for 

generation of challan) till that time can only be edited. The same will have both “Edit” & “Delete” tab 

in column “Action” corresponding to them. Candidate whose data has been submitted to the council 

(i.e. those that have been submitted for generation of challan) can only be viewed. The same will have 

“View” tab in column “Action” corresponding to them.     
 

iii) For Editing: In Action column click on “Edit” tab, this will open the candidate’s information sheet in 

edit mode to enable the user to make the desired modifications in the candidate’s data.  
 

iv) For Deleting: In Action column click on “Delete” tab to delete the candidate’s database.  
 

v) For Viewing: In Action column click on “View” tab to view the desired candidate’s details. 

 

NOTE:  
a. The system will reject all second and substituent entries identified by it as duplicate at the time of 

final submission and generation of challan. Hence please be careful at the time of entering 
candidate’s data in the system. 

 

b. Candidate whose data has been submitted for generation of challan can never be modified.  
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10. GENERATE CHALLAN: Final submission of data and generation of bank challan. 
 

In this page data of candidate(s) for which challan has not been generated till that time will get displayed.    
 

a. For candidate’s data of the current registration session (data made available from Council end), 
will be visible in this page only after the same has been modified by the user. 
 

b. For candidate’s data added by the user, the same will be visible in this page after checklist of 
the same has been generated.  

 

Corresponding to each candidate data; column “STATUS” will contain the word “Awaiting Final Submit” 
and also a checkbox will appear beside the same. 

 

 
 

For final submission of candidate(s) data and generation of challan follow steps as mentioned below: 
 

i) Select all the candidate’s record you wish to submit for generation of challan. 
 

ii) Click on the “Checkbox” appearing in the Declaration para and thereafter click on the “Final Submit” 

tab. The system will do a self-check for duplicates (if any) amongst the data selected and also the data 

previously submitted (if any).    
 

iii) All duplicate entries identified by the system will get marked, also an indicator with a remark “This is 

a duplicate entry” will appear corresponding to each duplicate data and the system will automatically 

drop the same during the process of challan generation.   
 

iv) Thereafter an overlay screen will appear in the screen, atop the challan generation page asking for 

final confirmation pertaining to the accuracy of data you are submitting for generation of challan.  
 

v) Upon clicking on the “Final Confirm” tab the system will consider the same as submitted for 

consideration in Examination database of the year (provided payment for the same has been received 

by the Council within the stipulated time) and generate a bank challan with requisite details for 

payment of requisite fees into the bank. Else on clicking on the “Cancel” tab the system will reload the 

generate challan page. 
 

vi) The challan generated will get downloaded into the user’s computer’s browser default location in PDF 

format.  
 

vii) Double click on the file to open the same for printing. 
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11. OBTAIN CHALLAN ANNEXURE: Download of Challan Annexure. 
 

After successful generation of bank challan from this page a user can download the challan annexure. The 

challan annexure contains fees payable by each candidate who have been selected in the previous step for 

generation of bank challan. 
 

 
 

i) In order to download the challan annexure corresponding to a challan, click on the “Print Annexure” 

tab appearing in column “No of Students”. The challan annexure will get downloaded into your 

computer’s browser default location in PDF file format. Double click on the file to open the same for 

printing 
 

ii) In order to obtain additional copies of a Bank Challan, click on the “Print Challan” tab appearing in 
column “Action” corresponding to the same.  

 

NOTE:  
a. Duplicate copy of the bank challan is available till the same is not approved in the system. 

 

b. Challans which are not approved in the system will contain a mark “Unapproved” in column 
“Status”, upon approval of the same the mark will change to “Approved”. 

 

12. MAKE PAYMENT INTO BANK : 
 

In order to pay the requisite fee; visit any branch of The Assam Co-operative Apex Bank Ltd. with a copy of 
the system generated challan.  
 

After submission of the fee please keep the counter foils of the challan in safe custody. (You are required 
to submit the part marked as council copy of the challan in original along with the system generated final 
statement to the Council.) 

 

NOTE:    
a. Before making payment satisfy yourself that the Institution Code and Name appearing in the challan 

is of the Institution whose data has been submitted for generation of the challan. 
 

b. No of candidates mentioned in the challan & the challan annexure are same. 
 

c. The challan should be submitted before the last date as mentioned by the Council after duly filling 

all requisite columns. 
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13. FINAL STATEMENT & QUESTION PAPER REQUISITION STATEMENT:  
 

A Consolidated Statement (Statement of Candidate’s Appearing in the Examination) and a Question Paper 
Requisition Statement corresponding to a challan gets automatically generated only after confirmation of 
payment of fees is received from the banker corresponding to the same.  
 

In order to obtain the Statement of Candidate’s Appearing in the Examination, go to page “Print Final 
Statement” by clicking on the tab. List of all approved challans till that time will get displayed in a tabular 
format.  

 

i) In order to obtain the consolidated statement corresponding to a challan click on the “Print” tab 
appearing in column “Action” against the same.     

 

ii) In order to obtain the question paper requisition statement corresponding to a challan click on the 
“Form No 11(a)” tab appearing in column “Payment Amount” against the same. 

  

The consolidated statement contain list of all those candidates who has been selected for generation of the 
challan.  
 

14. SUBMISSION OF DOCUMENTS WITH THE COUNCIL : 
 

After printing of the Statement of Candidate’s and the Question Paper Requisition Statement the head of 
the institution is required to put his seal and signature in all places marked for the same. 
 

Thereafter the user is required to stitch tag together the Statement of Candidate’s, the Question Paper 
Requisition Statement and part of the Challan marked as “COUNCIL COPY” (containing the banks receiving 
seal) and submit the same to the council at such specified location and within such specified place as 
notified by the council.   

 
 

**** END **** 


